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Virtual Library 

Using the Resources of 
Local Libraries 

Nancy K. Herther, University Libraries 

(1J Need a journal that isn't in the 
University collections? 

(1J Want to read a top-selling novel 
over the weekend? 

(1J Hoping to get some good VCR 
movies for the weekend? 

(1J Want to listen to today's top 
audio CDs at home? 

(1J Want to sign up your child for a 
story telling program? 

Anyone at the University is entitled to use any of the 
public libraries in the metropolitan Twin Cities area. The 
University Libraries have made this a bit easier by putting 
the on -line catalogs of the various public libraries on our 
Gopher/LUMINA menu system. 

What's Involved? 
Ar; shown in Figures 1 and 2, once you are in Gopher, 
select 

Libraries 

then select 

Library Systems in the Twin Cities 
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Each system will have Its own sets of 
commands, features and screen layouts. 

Figure 1: Select 
Library Systems in the Twin Cities 

Libraries 

University of Minnesota Libraries 
Electronic Books 
Electronic Journal collection from CICnet 
Government Information 
Government Information 
Library Catalogs via Z39.50 
Library Card Catalogs via Telnet 

~ Library Systems in the Twin Cities 
Library of Congress Records 
MINITEX Veronica service 
Newspapers, Magazines, and Newsletters 
Reference Works 

Figure 2: Currently Available Library Catalogs 

Library Systems in the Twin Cities 

Anoka County Public Library 
Augsburg College Library 
Bethel College Library 
Carleton College Library 
College of Saint Catherine Library 
Concordia College Library 
Dakota County Public Library 
Hamline Law Library 
Hamline University Library 
Hennepin County Public Library 
Ireland Theological Library 
Macalaster College Library 
Minneapolis Public Library 
Ramsey County Public Library 
Scott County Public Library 
St. Paul Public Library 
University of St. Thomas Library 
Washington County Public Library 

Computer and ... 

Library Systems In the Twin Cities 
Many of the libraries are dial-up options at this 
time - they are not on the Internet yet - and 
so access to the databases will be dependent on 
available ports into the library's computers. Each 
system will have its own sets of commands, 
features and screen layouts. All are menu-driven 
and quite easy to use. 

I have noticed that some are difficult to get into 
during regular working hours, and many are also 
busy during the early evening hours. Remember, 
you are 'competing' with school and public users 
from across the Twin Cities and many of the 
libraries don't have the resources to invest in 
adequate ports to handle their busiest times. 

You can also dial-up using a regular modem 
connection, if you wish. Each library in the 
metro area has handouts describing their on-line 
systems; you can call them for more information. 

Variety and Function 
Any of these catalogs will tell you what materials 
are available through their on-line catalogs. Each 
library will have its own policies on exactly what 
is cataloged. Some libraries, for example, do not 
catalog all of their materials (such as paper­
backs); so if you don't see something in the 
catalog, be sure to call them and ask. They 
should also be able to indicate whether or not 
the material is currently checked out (just as you 
can do with our collections here at the Univer­
sity). 

However, from tl1ere things get quite interest­
ing! Most public libraries will give you additional 
information on a variety of topics - for example 
all will give you information on library locations, 
hours and services. Circulation and special 
services will also be available. 

Special children's or adult programming is also 
listed so that you can find out quickly if there 
will be any special films, story hours, public 
meetings or other events at your library of 
choice. 
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The Ramsey County Library on-line system has a 
feature that I found very interesting. You can send 
reference questions to the library staff via the on-line 
system, and the answers will be posted on a bulletin 
board portion of the system so that everyone has a 
chance to see what's hot or get helpful information. 
For example, information on help getting your taxes 
done, 800 numbers to check on product recalls or 
information on the O.J. Simpson trial. 

Checking It Out 
Many of these systems will also allow you to check 
your personal library records, allowing you to see 
how many books or other materials are currently 
checked out to your account, letting you renew 
materials that you want to keep longer, etc. 

If you run into any problems using these systems -
and certainly if you see any discrepancies in your 
records- be sure to contact that library to get 
things straightened out. Each library system in the 
Twin Cities has its own policies on which materials 
can be checked out, who has access to what materials, 
length of loan periods, etc. This isn't something that 
the University Libraries can mediate for you. 

Who Can Use This? 
Anyone - here in the Twin Cities or around the 
world- can use these databases, just as anyone can 
use the MNCAT catalog to the University of Minne­
sota collections. There may be -just as we have in 
LUMINA- certain information or databases from 
other libraries that are restricted in some way. 

Do you have a public library card? Call your local 
public library to get details on what you might need 
to bring for identification. Anyone currently living in 
the metropolitan area is qualified to get a public 
library card; you don't have to be a citizen or a 
permanent resident in order to get these cards. Of 
course, anyone- with or without a card- is en­
titled to use tl1ese libraries. However, without a valid 
public library card, you may not be able to check out 
materials and take them home with you. 

The University Libraries work with other 
libraries In the Twin Cities area 

to guarantee that the 
University community and the 
public are able to get at the 

Information they need. 

We Cooperate 
Public libraries play an important role in our society: 
gathering sources of general information, recreational 
and educational materials; providing meeting space 
for civic and cultural events; special programming for 
their communities. 

They also provide an important networking role for 
the University community. The University Libraries 
work witl1 otl1er libraries in the Twin Cities area to 
guarantee that botl1 tl1e University community and 
the public are able to get at the information they 
need. The University Libraries rely on the public 
libraries to meet many of tl1e general and recreational 
needs of the community and these libraries depend 
on the University to meet the more challenging, 
research-oriented needs that tl1e public may have. 
We don't compete, we cooperate. 

So, next time you want to check out "The Lion 
King" for tl1e kids, get Grisham's latest tl1riller, or 
just check out some periodical that isn't held at the 
University Libraries, give tl1ese library catalogs a try! 

For More Information 
For more information on these catalogs, please check 
LUMINA, contact your local library or feel free to 
contact me, Nancy Herther, Manager, Integrated 
Information Center, 7 Walter Library, East Bank, 
624-2020; Internet: nherther@iic.lib. umn.edu. 
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Library Classes 
Science & Engineering Resources on the Internet 

' 
Walter Library's Science and Engineering 
Reference section is offering Internet training 
for its patrons. 

1. Internet Basics: Using Common Tools and 
Navigators: a 1.5 hour class offered three times: 
for DOS on April4, 1:30-3 pm and April11 
(faculty only), 9:30-11 am, and for Macintosh on 
May 10, 1:30-3 pm. 

2. Advanced Internet: Science & Engineering 
Resources: a1.5 hour class offered three times: 
for DOS on April18, 9:30-ll am and April26 
(faculty only), 1:30-3 pm, and for Macintosh on 
May 17, 1:30-3 pm. 

3. Web Publishing Basics: Content & Design Issues: 
a 1.5 hour classes offered twice: for DOS on 
May 2, 9:30-11 am and for Macintosh on 
May 3, 1:30-3 pm. 

Advance registration is required. For more informa­
tion about these classes, telephone 624-3535 or send 
E-mail to 

k-alst@vml.spcs.umn.edu 

Microcomputer Price & Comparison Lists 
on Gopher in PDF Format 

Product description and 
comparison handouts as well 

as the computer price lists tor 
products sold through the Book 

Center's Computer Store have 
been available electronically via 

Gopher for a long time. 

Acrobat PDF Format 
Now these documents are also available as PDF 
(Portable Document Format) documents. To view or 
print them in that format you need Adobe's free 
Acrobat Reader software. (The Acrobat family of 
products were the subject of several articles in our 
March 1995 newsletter.) 

Where are They? 
To find these documents you can follow the paths 
listed below from the University's Home Gopher 
location. Ifyou have not "picked up" the free Reader 
software, we've made it easy for you to obtain it; 
you'll find the Mac and Windows versions in the 
"Electronic Inventory" section. Follow either of 
these Gopher paths: 

Computer Information 
U of MN Microcomputer Prices 

Acrobat 

U of MN Bookstores Electronic Inventory 
Computer_Pricelists_in_PDF 

These exact locations may change. We are experi­
menting with the best way of making this price and 
product information available to you. 
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Working Smarter 
Using Word 6's Style and Template Options 

Word 6: Styles and Templates 
If you want to "work smarter" and let 

your computer software do more 
work for you, try using Micro­
soft Word's styles and templates. 

The next time you create a docu­
ment, instead of applying formats 

(such as bold, italic, and font size 
changes) directly, use Word's built-in styles or create 
your own styles. Using styles makes it much easier to 
maintain consistent formatting throughout a docu­
ment and to change formatting later on. If you are 
creating a series of similar documents, use Word's 
templates. Templates already contain tl1eir own styles. 
Microsoft Word 6.0's styles and templates for 
Macintosh and Windows are nearly identical. 

What Are Templates? 
A template is a blueprint tor documents of a particu­
lar type, such as letters, memos, or brochures. Word's 
templates have preset formatting information and 
contain built-in paragraph and character styles. 

If you performed a complete installation of Microsoft 
Word 6.0, all oftl1e templates are available. These 
include brochure, directory, fax cover sheet, letter, 
manual, manuscript, memo, presentation, press 
release, report, resume, and thesis. If you did a typical 
installation on a Mac, you have access to the letter, 
memo, and fax cover sheet templates. (To have access 
to all templates, you must run Setup again.) 

What Are Styles? 
A style is a group of character and paragraph format.o; 
identified by a name, such as Title, Heading, Body 
Text, or List. You can format a section of text with 
both a paragraph and a character style. 

Character and Paragraph Styles 
Types of character fonnats include font, font size, 
and font style. Types of paragraph formats include 
indentation, line spacing, paragraph spacing, tabs, 

and borders. (A paragraph is an amount of text or 
graphics followed by a paragraph marker (1). Note: a 
paragraph marker on a blank line is also a paragraph.) 

Word provides a set of standard styles for all docu­
ments. The particular styles that are provided are 
determined by the template on which you base your 
document. Some examples of tl1e names and appear­
ance of typical Styles are listed in Figure l. 

Using Templates and Styles 
Let's create a series of brochures. We'll use templates 
and styles to make our job easier. Our first step is to 
select New from Word 6's File menu. This brings up 
the New dialog box which shows a list of templates 
we can choose from. 

If you click on OK without choosing a style, Word 
will base your document on the Normal template and 
apply the Normal style to all new text that you type 
into it. 

What's the Normal Style? 
The Nonnal style is 12 point, single spaced, flush left. 
On the Mac the font is Times; under Windows the 
font is Times New Roman. 

Figure 1: Paragraph Style Examples 

Title 
Normal + Font: Helvetica, 20 pt, Bold, Centered, 
Space Before: 12 pt After 3 pt 

Heading 1 
Normal + Font: Helvetica, 14 pt, Bold, Space 
Before: 12 pt After 3 pt, Keep With Next 

Body Text 
Times, 12 pt + Space After 6 pt 

1. List Number 
Normal+ Indent: Hanging 0.25", Auto Numbering 
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An Example: Creating a Brochure 
We'll choose the Brochure 1 template from the list. 
When our new document opens up it is based on that 
template, and the Body Text style is selected. The 
Body Text style in this sample is 10 point, single­
spaced, flush left, Space After 8 pt. On the Mac the 
font is Times; under Windows the font is Times New 
Roman. Any text we type in will have those charac­
teristics. We can also apply other styles from the 
Brochure l template to our text. 

The "Space After 8 pt." is a Paragraph option. You 
can use it instead of separating each paragraph with 
the blank space you get when you use the [Return I key 
twice. This option gives you greater control over how 
much space separates paragraphs in your document. 

Applying Standard Styles 
There are two ways to apply styles in Word. You can 
use the Style command from the Format menu or you 
can use the Style box on the Formatting Toolbar. 
Using the Formatting Toolbar option is quicker, but 
the Style command lets you preview options bd()re 
applying them. 

The Formatting Toolbar 
The Style box on the Formatting Toolbar initially 
lists some commonly used built-in styles as well as 
any styles that are created, modified, or used in the 
document. Paragraph styles are boldface. Character 
styles are in plain text. If the style you want is not 
displayed in the list, hold down the (Shift) key while 
clicking on the T beside the Style box. 

Select the paragraph or character style you want to 
apply to your text. When you release the mouse 
button, the selected style will be displayed in the 
Styles box. Whatever text you type in will automati­
cally be formatted in that style. 

The Style Command 
If you choose the Style command from the Format 
menu, Word will bring up the Style dialog box; 
Figure 2 shows an example of this dialog box. In the 
Style dialog box, Word lists all the styles currently 
available to you. Select the style you want by clicking 
once on it. A.'.; shown in Figure 2, you can preview 
the paragraph and character formatting. The Descrip­
tion section gives you additional information about 

Figure 2: Style Dialog Box from the Format Menu 

Style~: 

List Number 2 
List Number 3 
List Number 4 
List Number 5 
List Number First 
List Number Last 
Macro Text 
Normal 
Page Number 
Picture 
Return Address 
Subject Line 
Subtitle Cover 
Su 

Style 

Paragraph Previey-----------------------, --------------------
SUlple Title ------------------------

ha racte r P revi eY--------------------------. 

Helvetica 

Description-------------------------------, 
Heading Base + Font : 20 pt, Centered, Space Before 36 pt 
After 8 pt 

~-------------------------~'~~'L----------------------------------------------------------~ 

( Applg , 
( Cancel ) 

( NeY ... ) 
( Modifg ... ) 
( Delete ) 

(Organizer. .. ) 

( Help ) 
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the style you've selected. When you have made your 
choice, click on the Apply button. 

Some of the standard styles you may want to use in 
your brochure might include: title cover, subtitle 
cover, heading (levels 1-9), or list (bulleted or num­
bered, levels 1-5 ). 

Modifying Styles 
Once you have applied styles to your document, it is 
easy to make changes to tl1e fonnatting. Rather tl1an 
tediously selecting each section of text and changing 
its format, you can change the description of tl1e style 
that has been applied to tl1e text. For example, you 
might want to change the Body Text style from 10 
points to 10.5 points or change the spacing between 
paragraphs. Once you modifY a style, all of the text in 
your document tlut has tl1at style applied to it will 
automatically be updated. 

You can use tl1e Formatting Toolbar or the Style 
command to modifY styles. 

Using the Style Command 
Choose Style from the Fom1at menu, and select the 
name of style you want to modifY. 

Modify Heading 1 
For our example we'll select HeadinlJ 1 and click on 
the Modify button. Note: if the style you want is not 
listed, you can select another category from tl1e List 
box, shown in tl1e lower left comer of Figure 2. 

In the Modify Style dialog box, click on the Format 
button. (On the Mac hold the mouse button down 
while you click on tl1e Format button.) Your "for­
mat" options include Font, Paragraph, Tabs, Border, 
and more. 

For our example, we'll choose the Paragraph option 
so we can change the "Spacing Before and Mter" 
options. Once we've made our spacing selections and 
clicked on all tl1e OK buttons, the magic begins. All 
text formatted with the Heading 1 style is updated 
throughout our document. 

Using the Formatting Toolbar 
You can get tl1e same results from using the Format­
ting Toolbar; only the steps are different. For our 
next example, we'll choose a paragraph with the Body 
Text style applied to it. 

To use tl1e Style box on the Formatting Toolbar to 
modifY a style, you must first select a paragraph 
formatted with the style you want to modifY. Then 
you manually make changes; for example, change the 
font size of the text from 10 to 10.5 point. 

When you've made your selections, click in tl1e Styles 
text box and press [+-'Return) (Mac) or [+-'Enter] (Win­
dows). As shown in Figure 3, Word will respond by 
displaying the Reapply Style dialog box. If you re­
spond OK to redefining tl1e style, Word will auto­
matically reformat all text that has tl1at style applied 
to it; in our example tlut style is called Body Text. 

Figure 3: Result of Using Formatting Toolbar 

Style: Body T~xt 

Do you 'w'a nt to: 

Reapply Style 

@Redefine the style using the selection as an example? 
QReturn the formatting of the selection to the style? 

lrt ( 
( 
( 

OK J 
Cancel ) 
Help ) 
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The based on option Is a powerful way 
to easily change the look of 

many paragraph styles. 

The Based On Option 
The based on option is a powerful way to easily 
change the look of many paragraph styles. In most 
documents, related text elements, like headings and 
lists, share many format options, such as font, font 
size, alignment, and paragraph spacing. When you 
use this option, you can quickly update the fonnats 
shared by a group of styles by modifYing the style on 
which those styles are based. 

Using the Style Command 
For our next example we'll use the Subtitle Cover 
style. Use the Format/Style menu to select the Sub­
title Cover style and click on the ModifY button. 

From the Based On section of the ModifY Style dialog 
box, you'll find that the style is currently based on 
the Title Cover style. For our example we'll select 
Heading 1 from the list (to replace Title Cover), and 
click on the OK button. 

Style for "Following Paragraph" 
In a typical document, headings are followed by body 
text. This pattern is often tme of other parts of a 
document. When you press [Return I (on a Mac) or 
(Enter! (under Windows) to end a paragraph, Word 
can apply a paragraph style that you specifY to tl1e 
next or "following paragraph." 

For example, in the Brochure 1 template, a paragraph 
formatted with the Heading 1 style is preset to be 
followed by text formatted with tl1e Body Text style. 

The ModifY Style and New Style dialog boxes have 
sections called Style for FollowinJr Para;_qraph that you 
can use to make appropriate selections. 

Creating New Styles 
If you know exactly what paragraph and character 
formats you want to add to your document, but none 
of the standard formats are close enough to modifY, 
you can create a completely new style. To do this you 
select the formats you want and give that particular 
group of formats a style name. 

There are two ways you can do this: 
1. Select a paragraph and apply character and 

paragraph formatting until it looks the way you 
want. Then you can use the Style command or 
the Formatting Toolbar to give the style a name. 

2. If you are familiar enough with character and 
paragraph formatting options to know what the 
result•• of applying tl1em will be, you can use the 
Style command to create a new style and assign 
formatting to it. Then apply this new style to text 
in your document. 

Using the Formatting Toolbar 
To create a paragraph style with the Formatting 
Toolbar, select a paragraph and format it. For our 
example we'll select some text for a subheading and 
make it: 14 pt, bold, Space Before 12 pt, Space After 
6 pt. When we've made all our selections we: 
• click in the Style text box on the 

Formatting Toolbar 
• type in a name, such as Sttbhead 1 
• press [Return I (on a Mac) or 

[Enter) (under Windows) 

Word automatically assigns your new style to the 
Style drop-down list. 

Using the Style Command 
You can do tl1e same thing with the Style command; 
only the steps are different. 

To create a new style with tl1e Style command, begin 
by clicking on the Ne·w button. This brings up the 
New Style dialog box, which lets you perform many 
functions, such as name the style and select format 
options. 
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Figure 4: Managing Styles with VIew Option 

Options 

r Save T S~ll~~ T Gr<muoor T Autoformat 

Revisions T User Info T Compatibility T File Locations 

Yiev T General T Edit T Print 

(~ ) Norma 1 View Options 
OK Shov 

O.Q.raft Font OEield Codes ( Cancel ) 
0 Wrap to Wi ndo'w' 0Boo.!5,marks ( Help ) 
OE.icture Placeholders Fi~ld Shading: 

!Never , ... , 
Windov Non p ri nti ng C ha racte rs-

[gJ Stat us ~a r Oiab Characters 

[g) Hori~ontal Scroll Bar O~paces 

[g) Vertical Scroll Bar 0 Paragraph Marks 
OQ.ptional Hyphens 

Style Area Width: 0 Hidden Text 
111 .. I~ De.n 

What Happens If You Delete a Style? 
If you delete a paragraph style that you created, Word 
will apply the Normal style to all paragraphs tc>rmat­
ted with that style. If you delete a character style that 
you created, Word removes the character style tor­
mats from any text formatted with that style. If you 
delete a built-in style, you can make that style avail­
able again by selecting All Styles in the List box. 

You have several options tor deleting styles. To delete 
individual styles, click on the Delete button in the 
Style dialog box. To delete multiple styles, begin by 
clicking on the Or._qanizer button in that same box. 

Managing Styles 
To see the paragraph styles that have been applied to 
an entire document, you can display the style names 
to the left of the document window. You can only do 
this in the Normal and Outline views. 

f-

1-

Select the View Tab 
To do this, choose Options from the Tools menu and 
select the View tab from the Options dialog box, as 
shown in Figure 4. In the Style Area Width text box 
(in the lower left hand corner) specifY a value greater 
than zero. When 0 (zero) is selected, the style names 
are hidden. 

Once you've selected a "Style Area Width," Word 
displays the style names alongside the document's 
text. You can manually adjust the view area by drag­
ging the style area boundary line. 

Help and Print Options 
To get detailed information about the formatting 
applied to a particular paragraph, click once on the 
Help button on the Formatting toolbar and point to 
a paragraph and click. This will bring up a box 
showing you the character and paragraph formatting 
applied to that text. 
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Figure 5: You Can Copy Styles Between Documents 

Organizer 

St"les Auto Text Tool bars Macros 

In Document2: To Normal: 

Picture [ Cop" H ] Default Paragraph Font ~ Return Address Normal 
yle 1 [ Delete ] 

ubject Line 
ubtitle Cover [ Rename ... ] 

~ 
Styles Available In: Styles Available In: 

loocument2 (Document) 1 ... 1 !Normal (Global Template) 1 ... 1 

[ Close File ) ~ [ Close File ] 
Description--------------------------------------------------~~~~~~~ 

Heading Base+ Font: 20 pt, Centered, Space Before 36 pt After 8 pt ~ Close J 

Word 6's Print dialog box has a option that lets you 
print a list of the styles in your document. 

Copying Styles From Another Document 
You can copy styles from one document or template 
to another; this is smarter than creating or modifYing 
the same style twice. To copy styles begin by clicking 
on the Or;ganizer button in the Style dialog box. 

Close File and Open File Buttons 
A~ shown in Figure 5, Word displays two styles lists. 
The styles used in the active document (or its at­
tached template) are listed on the lett. Styles used in 
the Normal document template are listed on the 
right. 

Click on the Close File button below each list. These 
buttons then change to Open File buttons. 

Use the Open File button on the left to open the tile 
you want to copy the styles from. Use the right Open 
File button to open the file you want to copy the 
styles to. 

( Help J 

Then select the styles you want to copy and click on 
the Copy button. You can use the Rename button if 
you want to change a style name. If you modifY the 
styles that you've imported, the changes only affect 
the current document. 

Caution 
If the imported style sheet contains styles with the 
same names as styles in the target document, the 
imported style overwrites the definition of the current 
style. 

Style Conflicts 
Has this happened to you? When you copy text from 
one document and paste it in to another, the text's 
format changes. 

These are the rules: if the style names attached 
(applied) to the text you copied also exist in the 
document into which it is copied, the text takes on 
the style's fonnatting in the second document. 
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On the other hand, if the styles applied to copied text 
don't exist in the document into which you paste the 
text, the styles are added to that document. And the 
text keeps its original formatting. 

Copy Carefully 
To avoid copying paragraph styles to a document, 
select only the text in the paragraph you want to 
copy-not the paragraph mark. When you paste this 
text into another document, the text assumes the 
formatting of the paragraph into which you paste it. 

Saving a Document as a Template 
Now we are done with our first brochure. We created 
it with the Brochure l template, entered text, applied 
standard styles, modified those styles, and created 
new styles. We had planned to create series of bro­
chures using the same format. The easiest way to do 
this is to save our first brochure as a "document" 
template. 

This is easy to do. Choose Save As from the File 
menu. In the Save Current Document as box, type an 
appropriate name, such as Brochure Template. In the 
Save File as Type section, choose Docummt Template. 

This step makes creating our next brochure much 
easier. To create our next brochure, we simply open 
the Brochure Template, replace the boilerplate text 
with new text and use the Save As command to name 
it and save the file type as a Word document. 

Is there an Easier Way to Use Styles? 
If you are in a hurry, you have a simple document, or 
you want to quickly change a document's overall 
appearance, you can use the AutoFormat or Style 
Gallery commands. 

AutoFormat 
Mter you have typed a document, you can have 
Word format it automatically by choosing 
AutoFormat from the Format menu. Even if you've 
already formatted some of the text, the AutoFormat 
command can quickly complete the t(mnatting, 
providing uniform formatting throughout the docu-

If you are In a hurry, 
you have a simple document, 

or you want to quickly change a 
document's overall appearance, 
you can use the AutoFormat or 

Style Gallery commands. 

ment. Any styles that you have already used to format 
the document will be preserved unless you allow 
Word to change them. 

To format the entire document, position the inser­
tion point anywhere in the document. To format part 
of a document, select the text you want to format. 
Next select AutoFormat from the Format menu. This 
brings up the AutoFonnat dialog box. 

Before Word formats your text, you may want to 
specify the options you want applied by clicking on 
the Options button. This takes you to the 
AutoFormat tab of the Options dialog box. By 
debult, all options are selected. Choose the options 
you want Word to use and click on OK Word 
analyzes the document and determines the character­
istics of the text, then applies appropriate styles from 
the Normal template (or another if you have selected 
one). 

Word will then display the AutoFormat dialog box. 
You can review and accept or reject the changes one 
by one, or scroll through the document and select 
the specific changes you want to review. 

If you want to format text automatically without the 
opportunity to reject any changes, use the 
AutoFormat button; it's on the Standard Toolbar 
under the Table menu. 

After using either technique, you can use the Undo 
button on the Standard Toolbar to undo all of the 
changes. 
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The Style Gallery 
Mter you have applied styles to your document, 
either directly or with AutoFormat, you can use the 
Style Gallery option to preview and change the 
document's overall appearance. To do this choose 
Style Gallery from the Format menu. The Style 
Gallery dialog box (Figure 6) shows you how a 
document will look if it is formatted witl1 particular 
template styles. 

If you double-click on a name from the Template list, 
Word will copy the styles in that template to your 
document and close the Style Gallery dialog box. 

If you haven't formatted your document first, the 
Style Gallery command will copy the styles from the 
template you choose to your document, but won't 
change the formatting until you apply the new styles. 

Mter you have applied styles to your document, you 
can use the Style Gallery command to preview and 
change tl1e document's overall appearance. 

How Can I Learn More About Styles? 
We offer short courses on Microsoft Word for 
Macintosh and Windows on a quarterly basis. 

To register for Intermediate Word: Styles for 
Macintosh or Windows, you must have mastered the 
skills taught in Introduction to Word and Intermedi­
ate Word: Paragraph Formatting. If you are using a 
Macintosh, you must also have mastered the skills 
taught in Macintosh Fundamentals. If you are using 
Windows, you must have mastered the skills taught in 
Mouse Techniques and Introduction to Windows. 

To find out more about current course offerings or 
how to register, look up the Computer and Informa­
tion Services Short Course Bulletin in Gopher: 

Computer Information 
Computer & Information Services Short Courses 

Figure 6: A "Preview Example" from the Style Gallery Dialog Box. 
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Bargains on the Mac Information Server 
Teleport Gold II Modem~ System 7.5 Update~ Word 5 & 6 Converters~ LaserWriter Pro Upgrade 

Mac Information Server via Gopher 
Gopher access to the University of Minnesota's 
Mac Information Server is an experimental ser­
vice; it is available only for Gopher clients on the 
University's Twin Cities Campus. From the 
Home Gopher follow this path: Computer In­
formation\ Macintosh Information Servers\ 
University of Minnesota Mac Information Server\ 
Information. 

Access must be restricted because the server 
contains items that may only be distributed to 
the University ofMinnesota under terms of a site 
license. These restrictions means that you need 
a valid University account to access the server; 
entry via the public access gopher client mnning 
on consultant.micro.umn.edu is disallowed. 

T Software Upgrade: 
Global VIllage Teleport Gold II Modem 

Packaged with the PowerMac 6115CD 
At press time we obtained a software upgrade for the 
Global Village Teleport Gold II modem. The 
Teleport Gold II modem is included in the 
PowerMac 6115CD package available through the 
Computer Store. This upgrade is especially i~1por­
tant for MacSLIP users who want to use the 14,400 
bits per second (bps or "baud" rate) capability of 
that modem. 

Installing the upgrade is easy; the "updater" replaces 
the driver for the Teleport Gold II modem. Without 
the upgrade this modem cannot communicate with 
the University's SLIP modem pool at 14,400 bps. 
(Without this patch MacSLIP users at the University 
must set the MacSLIP/ConfilJUre options to 9600 
for speed and unselect these flow control options: 
RTS/DTR and CTS.) Once the upgrade is installed 
we recommend that MacSLIP users set the Confi.._q­
ure/Spccd option to 38,400. 

Obtaining the Upgrade 
We can distribute this upgrade at no cost to the 
University community; others can obtain Upgrade 
2.5 for about $25 from Global Village. By the time 
you read this the upgrade will be available on the 
Mac Information server. 

Is Your MacSLIP Up-to-Date? 
The latest version of the MacSLIP Network Kit 
includes MacSLIP 2.0.6 and MacTCP 2.0.6; it also 
includes the Global Village Teleport Gold II modem 
in its Modem list. (This modem selection works with 
or without the upgrade.) If you do not find that 
option on the drop down Modem list, you can sign 
for and pick up a new copy of the MacSLIP software 
in any Microcomputer HelpLine. Alternatively, the 
adventurous can use the "edit modems" option to 
customize the Global Village Teleport modem 
selection to use this initialization string: 

AT &Fl NO S37=0 

T System 7.5 Update 1.0 
Apple recently released a free update to its Mac OS 
(operating system). We encourage System 7.5 users 
to obtain this update. Installation is easy; the Installer 
will automatically determine what software your 
model of Macintosh needs. Beginning in April1995 
the update will be included on computer systems that 
Apple sells. 

Some enhancements delivered by the System 7.5 
update include "improved handling of low memory 
situations, faster File Sharing,ability to tum off the 
computer using the keyboard Power On key." 

Hardware Specific Enhancements 
Power Macintosh 

Native QuickDraw speeds up operations such as 
scrolling, image filtering, and pattern and text 



Page 194 April1995 Computer and ... 

drawing. The updated Serial Driver fixes a poten­
tial crash problem. 

Power Macintosh 
(including those with the Power Mac upgrade card), 
Centris 660AV, Quadra 660AV, and Quadra 840AV 

Updated video software prevents scrambled video 
when the computer starts up. 

Performa 630 series, PowerBook 150,Quadra 630, 
and LC 630 (models with internal IDE hard disks) 

The update fixes a problem that prevents the 
internal IDE disk from appearing on the desktop. 
The problem occurs when the internal IDE disk 
is the selected startup disk, but the computer is 
started up from an external hard disk by holding 
down the <Command <Shift <Option <Delete 
keys during startup. 

PowerBook Duo docks 
Pressing the eject button automatically launches 
items in the Shutdown Items folder and shuts 
down the computer. No dialog box appears. 

PowerBook 500 models 
Improves trackpad performance. 

PowerBook 150 
The update extends battery life by reducing 
power requirements during sleep mode. It also 
fixes a potential system freeze problem that 
occurs when you use the internal modem several 
times without restarting the computer. 

Obtaining the Update 
The update is available on the Mac Information 
Server in the directory listed below. To copy it you 
need four 1.44MB disks. The readme flle that accom­
panies the update includes more detailed information 

about the software, including information about the 
LaserWriter 8 printer drivers. 

System Updates, Drivers, etc. 
Other System Updates 

System 7.5 Update (1.0) 

The update will also be posted on the following 
Apple Internet sites: Apple Computer Higher Educa­
tion gopher server; ftp.support.apple.com; 
ftp.info.apple.com. The update will be posted as two 
separate folders within the Apple Software Updates 
fc>lder; one section for the System 7.5 Update and 
another for the QuickDraw GX 1.1 software. 

T Word 5 and Word 6 Converters 
Those whose use or must exchange documents with 
Microsoft Word 5 and Word 6 users will probably be 
interested in the converters discussed here. 

Obtaining the Converters 
Converters for Microsoft Word 5 and Word 6 are on 
the Mac Information Server. Below are two paths you 
can take to access the Word 5 and Word 6 converters. 

From the C Menu's Chooser select: 
Macintosh Infom1ation server 

Applications 
Software Updates 

Word 5.x Converters 
Word 6.0 Converters 

Or, f()llow this path from the Home Gopher: 
Computer Infonnation\Macintosh Information 
Servers\ University of Minnesota Mac Information 
Server\Information\Applications\Software Updates 

Those whose use or must exchange documents with Microsoft Word 5 
and Word 6 users will probably be Interested In the converters discussed here. 
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Word S.x Converter 
A free converter which allows Microsoft Word 5.x for 
the Mac to read files created by Word 6.0 for the 
Mac, Windows, and Windows NT is available. The 
converter does not support savir1._11 flies into Word 6 
format; and, of course, fonnatting features in Word 6 
that do not exist in Word 5 will not be retained in 
the conversion. The Update Read Me document that 
accompanies the converter discusses other limitations 
that may arise when converting Word 6 documents 
into Word 5.x format. 

Once the converter was installed, we were able to 
double click on Word 6 documents and have Word 5 
open them. When we used the File/Opm menu, the 
Word 6 documents were listed once we selected All 
Files as the List Files of Type option. 

Installing the Word 5 Converter 
These instructions are part of the ReadMe Bej(we 
Installation file that accompanies the converters. 

l. Quit Microsoft Word. 
2. Copy the file Word 6.0 j(Jr Windmvs&Macintosh 

to your Word Commands folder. 
3. Move the file "Word 6.0 for Windows/ 

Macintosh" to the trash, if it exists. (Note: the 
difterence between this tile name and the file you 
just copied is the & symbol.) 

When you restart Word, the converter will be prop­
erly installed. 

Word 6 Converters 
If you're missing some converters this "package" may 
help; it has converters for these formats: 
• MacWrite II 
• Word for MS-DOS( version 3.0- 6.0 
• Word for Windows version l.x 

(only required for export) 
• Works for the Macintosh versions 2.0-3.0 
• WordPerfect for the Macintosh versions 2.x-3.x 

More information about the supplied converters and 
filters is included in the on-line document that is 
installed with the converters. 

Installing the Word 6 Converters 
These instructions are part of the ReadMe Before 
Installation document that accompanies the 
converters. 
l. Quit Microsoft Word 
2. Copy all convertor files to your Word Extensions 

folder; most people will find this folder inside 
their Word 6 folder. 

When you restart Word, the converter will be prop­
erly installed. 

T LaserWrlter Pro Software Upgrade 
An Energy Saving Upgrade 
This upgrade provides energy savings capability to 
the LaserWriter Pro 600 and 630 printers. Apple 
developed the upgrade to meet the requirements of 
the Environmental Protection Agency's Energy Star 
program. 

What Does It Do? 
The upgrade "allows users to set the sleep mode on a 
LaserWriter Pro printer. The sleep mode is the period 
of time a printer waits (when not printing) before 
going to sleep. In sleep mode, the LaserWriter Pro 
printer use approximately 70% less power than when 
in normal itlle mode." 

Obtaining the Software 
The software is on the Mac Infonnation server. To 
obtain it, follow this path: 

Sys Updates, Drivers, Etc. 
Printers and Fonts 

Laser Printer Software 
LaserWriter* Pro Energy Star% 

The software is also available via anonymous FTP 
from ftp.support.apple.com and from the University's 
Home Gopher menu by following this path: 

Computer Information \Apple Computer World 
Wide Tech Support. 



Page 196 April1995 Computer and ... 

Computer Store: 625·3854 
You can charge your purchases on your MasterCard, VIsa, and Discover accounts. 

-. Computer Discount Program 

[II] The discount program is available not 
only to departments but also to stu­
dents and staff, subject to the eligibility 
rules of the program. The Computer 
Store is located in the East Bank Book 
Store in Williamson Hall. During 
Spring, Winter, and Fall quarters the 
Computer Store is open • Monday­
Friday 8:30-6:00 • Saturday 10-4. 

7-Day Protection 
Your purchase price is protected for 7 days from the 
time you receive your product. If the price drops 
during that time, you can bring in your receipt for a 
refimd. The Computer Store offers a one-week 
money back guarantee on hardware and on any 
software whose seal has not been broken. Of course, 
you must present your sales receipt; a few other 
common sense restrictions also apply. 

Free E-mail Updates 
To get product and price change bulletins for the 
products sold through the Computer Store sent to 
you electronically, subscribe to the Bookstore prices 
list by sending E-mail to: 

request@boombox.micro.umn.edu 

Use Gopher for 24-hour Service 
Use Gopher to search the Computer Store's data­
base to find out part numbers, prices, and product 
availability. "Electronic ordering" options are also 
available by following these paths: 

University of Minnesota Campus Information\ 
Department and College Intormation\Minnesota 
BookCenter Electronic Desk 

Computer Information\U of M Microcomputer 
Prices\BookCenter Electronic Desk 

-. IBM Price Drops 
In March IBM dropped the prices on most of their 
desktop computers and servers. Table l includes 
samples of some of the new prices. 

Table 1: Sample Price Changes 

Model/ CPU Speed RAM Hard Disk New 
Part No. MHz MB MB Price 

These configurations do not come with a monitor. 

PC 330: 64 bit SVGA, VESA & ISA, Energy Star 
6571L4G DX2 66 8 365 $1365 

PC 330: 64 bit SVGA, PCI & ISA, Energy Star 
6573L5F DX2 66 8 540 1535 

Performance Series Desktop: 256K cache 
6482X4F DX4 100MHz 8 364 1705 

Performance Series- Multimedia: 2X CD-ROM 
6482LPF 486DX2 66 8 364 1845 

Hardware Tidbit: PCI Local Bus 
The PCI (Peripheral Component Interconnect) is a 
high-performance local bus that was developed by 
more than 150 companies, including IBM and Apple. 
Bandwidth devouring peripherals, such as video and 
graphics components, can run into bottlenecks when 
data is transferred between the computer and the 
components. The PCI is designed to eliminate these 
bottlenecks. 

Individuals must add 7% sales tax to all Computer Store prices. Departments do not pay sales tax. 
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T IBM DOS 7 
Below are excerpts from IBM's press release about 
PC DOS 7. The full announcement was mailed to 
Microcomputer News subscribers; more information 
about this electronic bulletin service is available on 
the back page of this newsletter. 

PC DOS 7 frees up about 40K of conventional 
memory; it also frees up disk space because it comes 
with Stacker compression software. 

PC DOS 7 includes ... an extensive on-line help 
system; and exclusive features designed for 
mobile users, such as file synchronization, dock­
ing capabilities and the latest support trom 
Phoenix Technologies for PCMCIA cards. PC 
DOS 7 is IBM's 14th release of industry-standard 
DOS ... PC DOS 7 is the best upgrade choice for 
MS-DOS users who want to enhance their DOS 
and DOS /Windows environments without taking 
the step to a 32-bit operating system .... PC 
DOS 7 provides users with as much as 40K.B 
more conventional memory than DOS version 
6.x. This means there's more memory available 
for Windows, games and memory-hungry 
applications ... .IBM also has integrated Stacker 
4.0 for DOS and Windows into PC 
DOS 7 ... Stacker 4.0 provides more available disk 
space than other technologies, and users can 
easily upgrade to PC DOS 7 trom MS-DOS 
DoubleSpace and DriveSpace, IBM SuperStor/ 
DS and earlier Stacker versions without decom­
pressing existing files ... PC DOS 7 upgrades any 
DOS version 3.3 and higher and is supported on 
all IBM and IBM-compatible PCs. 

Obtaining the Software 
You can purchase the IBM DOS 7 upgrade for $45 
from the Computer Store. The software comes on 
3.5-inch disks. 

PC DOS 7 upgrades any 
DOS version 3.3 and higher and 

Is supported on all IBM 
and IBM-compatible PCs. 

T IBM Software 
In March we received the information below about a 
change in the software that IBM is bundling with 
their systems. The change applies to systems such as 
the PC 300 models that ship with 8MB ofRAM. 

New Offerings: Select-a-System 
Select-a-System {is a} ... set-up process that gives 
customers both OS/2 Warp and DOS/Windows 
on their PC at no increase in price. 

Select-a-System, which will come standard on 
most IBM desktop and mobile PCs beginning 
this month, allows customers to quickly and easily 
select the operating environment they want to 
use by simply clicking an icon. Customers can 
even switch back and forth between the two 
environments. 

Select-a-System will come standard on all IBM 
ThinkPad, Aptiva, PC 300 and PC 700 models 
that ship with 8MB of memory. 

You can read the full announcement in the Gopher 
section shown in the URL in Figure l. 

Figure 1: IBM New Flashes 

<URL:GOPHER://isaac.engr.washington.edu:70/00/ibm/ccrinfo/> 
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Using Technology to 
Assist Public Schools 

A Satellite Broadcast cf? Higher EducationjK-12 Connection 

You're Invited 
The Office of Academic Computing and Infor­
mation Technologies has sponsored several 
satellite broadcasts. The broadcast sessions are 
free and open to the public. The next session is 
April27 at 2:30pm; all broadcasts are held in the 
Bell Museum Auditorium (on the University's 
Minneapolis Campus). 

April 27, noon-2:30, Bell Museum 
Higher EducationjK-12 Connection: 
Using Technology to Assist Public Schools 

Public education is in transition. Public leaders 
and educational leaders alike believe that educa­
tion must be restructured if it is to remain the 
cultural and economic foundation of a prosper­
ous democracy into the next century. But there 
are more exhortations to restmcture the public 
schools than prescriptions t<x doing so. 

Perhaps the most promising vehicles f(>r change 
are the same computer and video networks and 
technologies that are driving the industrial 
economy into the knowledge economy along the 
"information superhighway." 

But higher education, federal and state govern­
ments, and the private sector will have to work 
together with the public schools if the emerging 
National Information Infrastructure is to become 
a learning infrastmcture that enables the public 
schools to improve learning outcomes while 
serving as a primary socializing force tor the 
nation's children. This broadcast will explore the 
possibilities from a variety of perspectives. 

Public education 
Is In transition. 

More Information 
For additional information, 
background materials, or 
disability accommodations, 
please contact the Office of 
Academic Computing and 
Information Technologies at 
the University of Minnesota 
at (612) 626-9816. 

These broadcasts are a 
cooperative venture. The 
Office of Academic Comput­
ing and Information Tech­
nologies is sponsoring 
several broadcasts offered by 
the Institute for Academic 
Technology (IAT), a non­
profit partnership between 
IBM and the University of 
North Carolina at Chapel 
Hill on behalfof education .. 
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Free Help: Computing & Information Technologies 
University of Minnesota Accounts Phone Help Line Hours 

Distributed Systems: Microcomputers, Workstations, LANs 
Software, hardware, peripherals, local area networks ................................. 626-4276 ...... M-F ...... 9 am to 4 pm 

0 East Bank ......... 152 Shepherd Labs .................................................. above ............. above ..... above 
0 West Bank ........ 93 Blegen .................................................................. above ............. above ..... 1 pm to 4 pm 

0 St. Paul ............ 58 Biological Sciences Center .................................. above ............. above ..... 1 pm to 4 pm 

Central Systems 
These systems require a user name and password, which you get when you open an account. 

Qualified users can apply for grants to cover some computing related costs. 
0 EPX (Unix), NVE (NOS/VE), UZ (Uitrix), VX and VZ (VMS) ..................... 626-8366 ...... M-F ...... 9 am to 4 pm 
0 VM1 (IBM/CMS) 998 Coffey Hall walk-in consulting hours may vary .... 624-6235 ...... M-F ...... 9-11 am, 2-4 pm 
0 MEDLINE (MinnesotaMEDLINE on NVE) ............................................... 626-8366 ...... M-F ...... 9 am to 4 pm 

E-mail and Internet 
0 Call for help using your University account.. ........................................ 626-7676 ....... M-F ...... 9 am to 4 pm 
0 Forgot your password? Staff: call 626-8366. Students: go to any Computer Facility- e.g., 14 Folwell, 26 Lind, 

305 McNeal, HHH 50. Troubleshooting: if Maroon or Gold are down, you'll hear a status report at 626-1819. 
0 LUMINA: call if you have trouble connecting ....................................... 626-7676 ....... M-F ...... 9 am to 4 pm 

General Information 
Computer Store 
Williamson Hall Book Center ............................. 625-3854 

(inventory and prices also available on Internet Gopher) 

University Computing & Information Services 
Administrative Information Svcs. (AIS) Help desk ... 4-0555 
Biomedical Graphics, various locations .................. 6-3939 
Central Computing Services, 100 LaudCF ............... 6-1600 

Accounts: EPX, NVE (inc I MEDLINE), UZ, VX, VZ .. 6-8366 
Data Entry .......................................................... 6-8351 
Statistics Services ............................................. 5-2303 
System Status .................................................... 6-1819 
Tape Librarian .................................................... 6-1838 

Computer Facilities (also call individual facilities) .. 5-1300 
_FoiH 5-4896 _Lind 6-0856 _MeN 4-5367 _H H H 4-6526 +more 
Disability and Computing Services, voice/TTY ........ 6-0365 
Distributed Computing Services, 190 Shep Labs .... 5-1300 
Engineering Services, 103 LaudCF ......................... 5-1595 

Equipment Repair and Warranties ...................... 5-1595 
Faculty Resource Center (for appointment) ............. 5-1300 
Gopher Hotel (server set up for a fee) .................... 5-2303 
Kodak Printer Service ............................................. 6-1661 
St. Paul Computing Services, 50 CofH .................... 4-7788 

Accounts: VM1 (IBM/CMS) ................................. 4-7788 
Tape Librarian .................................................... 4-3482 
Statistics Services ............................................. 4-6235 

Software Services (contract programming) .............. 5-2303 
Supercomputer Center Help, 3030 SCC ................. 6-0808 
Telecommunications, 30 TelecomS 

Networking Services Information ........................ 6-7800 
Networking Services Repair ................................ 5-0006 

Training, Course Registration, 190 ShepLab .......... 5-1300 
U Libraries, Integrated Information Center .............. 4-2020 
University Networking Services, 130 Lind ............... 5-8888 

Associate Vice President and 
Associate Provost Academic Affairs 

Donald R. Riley, Professor ............................. 626-9816 

Access Information 
SLIP: 2400/14,400--------- 626-1920 
SLIP: ADI-100 and ITE (with MKO) 3-0291 

'8 Terminal settings for 
these systems are 8-1-N 
(8 data bits, 1 stop bit, 
no parity) unless other­
wise noted. The number 
you dial may depend on 
the modem's bps or 
baud rate. 

0 Internet addresses. 

0 Dial-in Server: 626-0300, 
-1200, -2400, -4800, -9600 

0 At 9600 Telecomm 
supports V.32 and MNP 
level 5 error correction. 

0 On campus ADI-100 and 
ITE setups use 626-2400. 

LUMINA: 300/1200/2400 ........................ 625-6009 '8 
V.32 ........................................................... 4-7539 8 
Telnet & tn3270 PUBINFO.AIS.UMN.EDU 0 

E-mail and Internet Service and Servers, Twin Cities 
MAROON. TC. UMN. EDU GOLD. TC. UMN. EDU 0 

Gopher, alternate access (log in as gopher) 
300, 1200, 2400, 9600 ............ see Dial-in Server 8 
-------- CONSULTANT.MICRO.UMN.EDU 0 

Consulting via E-mail: low priority Central System ques 

Format CONSULT@MACHINE.NAME.UMN.EDU 
AIS SecureiD V.32 ...................................... 626-1061 8 

300/1200/2400 ......................................... 6-7770 8 
tn3270 & Telnet ADMIN .AIS. UMN. EDU 0 

EPX, NVE (includes MEDLINE), UZ, VX, VZ 

300, 1200, 2400, 9600 ............ see Dial-in Server 0 
EPX or UZ or VX or VZ or NVE. CIS. UMN. EDU 0 

EPX, NVE: 300/1200/2400 ...................... 625-1445 '8 
up to 19.2 campus data phone .................. 3-2400 8 

VM1 (IBM/CMS) at 7-1-even 
9600 ..................................................... 624-3668 8 
1200/2400 & <19.2 campus data phone .. 4-4220 8 
___________ VMl.SPCS.UMN.EDU 0 

Trademarks: Internet Gopher and POPmail are registered trademarks of the University of Minnesota. 
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